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Cisco 7920 設定ユーティリティ
の使用

この章では、Cisco Unified Wireless IP Phone 7920 のネットワーク設定値および電

話設定値を設定するために、Cisco 7920 設定ユーティリティ バージョン 3.0 のイ

ンストール方法および使用方法について説明します。 次の項で、ユーティリティ

のインストール方法と使用方法について説明します。

• Cisco 7920 Configuration Utility のインストール方法（P.4-2）

• Cisco 7920 設定ユーティリティの使用方法（P.4-5）

• アプリケーション ウィンドウの概要（P.4-8）

Cisco Unified Wireless IP Phone 7920 の［ネットワークノセッテイ］メニューを使

用してネットワークの設定を行うこともできます。 第 5 章「Cisco Unified Wireless

IP Phone 7920 でのネットワーク プロファイルの設定」を参照してください。 
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Cisco 7920 Configuration Utility のインストール方法
この項では、Cisco 7920 Configuration Utility バージョン 3.0 とそのコンポーネン

トのインストール方法を説明します。

• システム要件（P.4-2）

• Cisco 7920 Configuration Utility のインストール（P.4-3）

• Cisco 7920 Configuration Utility のアンインストール（P.4-4）

システム要件

Cisco 7920 Configuration Utility をインストールして実行するには、ご使用のコン

ピュータが次のハードウェア要件とソフトウェア要件を満たす必要があります。

ハードウェア要件

• Microsoft Windows を実行する IBM 互換パーソナル コンピュータ（PC）

• CD-ROM ドライブ

• キーボードとマウス、または他のポインティング デバイス

• USB ポートとケーブル

（注） USB ケーブルを使用して、Cisco 7920 Configuration Utility を実行する PC
を電話機に接続します。 設定ユーティリティ ソフトウェアに付属の専用
USB ケーブルまたは標準 USB ケーブル（タイプ 2）が付いたデスクトッ
プチャージャーを使用できます。

ソフトウェア要件

PC で次のオペレーティング システムのいずれかを使用します。

• Windows 98（Second Edition）

• Windows Me

• Windows 2000 Professional（SP1 以降）

• Windows XP（Home Edition または Professional）

さらに、次のソフトウェアをインストールする必要があります。
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• Cisco 7920 Configuration Utility バージョン 3.0 以降。

• Cisco Unified Wireless IP Phone 7920 ファームウェア リリース 3.0 以降。

（注） Cisco 7920 Configuration Utility 3.0（またはそれ以降）は、Cisco Unified Wireless
IP Phone 7920 ファームウェア リリース 3.0（またはそれ以降）のみをサポートし

ます。 電話機で前のバージョンのファームウェアを使用する場合は、前のバー

ジョンの設定ユーティリティを使用する必要があります。

関連項目

• Cisco 7920 Configuration Utility のインストール（P.4-3）

• Cisco 7920 Configuration Utility のアンインストール（P.4-4）

Cisco 7920 Configuration Utility のインストール

Cisco 7920 設定ユーティリティは、CD を使用するか、Cisco Software Download

Center からそのソフトウェアをダウンロードしてインストールできます。

Cisco 7920 Configuration Utility をインストールするには、次の手順を実行します。

手順

ステップ 1 Cisco 7920 設定ユーティリティ CD を CD-ROM ドライブに挿入するか、ソフト

ウェアをダウンロードします。

ステップ 2 setup.exe ファイルをダブルクリックします。 InstallShield ウィザードのウィンド

ウが表示されます。

ステップ 3 InstallShield ウィザードは、インストール プロセスを実行するための手順を示し

ます。 Next をクリックして続行し、画面の指示に従います。

ステップ 4 インストールが完了したら、Finish をクリックします。
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インストール中に、次のファイルが指定された場所にコピーされます。

• Cisco7920.exe：メイン実行可能プログラム

• Expat.dll：XML パーサー

• <Cisco 7920 USB>：Cisco Unified Wireless IP Phone 7920 対応の USB ドライバ

（注） ファイルは、デフォルトで次のディレクトリ パスにインストールされま
す。
C:\Program Files\Cisco\Cisco7920ConfigurationUtility\Cisco 7920 USB 

Cisco 7920 Configuration Utility のアンインストール

Cisco 7920 Configuration Utility をアンインストールするには、Windows の［コン

トロール パネル］の［アプリケーションの追加と削除］を使用します。

関連項目

• Cisco 7920 Configuration Utility のインストール方法（P.4-2）
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Cisco 7920 設定ユーティリティの使用方法
この項では、Cisco 7920 Configuration Utility の使用方法に関する次の情報につい

て説明します。

• Cisco 7920 設定ユーティリティの概要（P.4-5）

• Cisco 7920 設定ユーティリティの電話機への接続（P.4-5）

Cisco 7920 設定ユーティリティの概要

Cisco 7920 Configuration Utility を使用して、Cisco Unified Wireless IP Phone で使用

可能なすべての設定値を設定できます。 Cisco 7920 Configuration Utility を使用で

きるようにするには、次の作業を実行する必要があります。

• USB ケーブルを使用して、Cisco 7920 Configuration Utility がインストールさ

れた PC に電話機を接続する。 

• 電話機の USB ポートを有効にして、設定ユーティリティ プログラムと通信

できるようにする。

• 接続を確立して電話機にログインする。

• Configuration Wizard を使用し、指示に従って電話機を設定する。詳細につい

ては、P.4-16 の「Configuration Wizard の使用」を参照してください。

• 上級ユーザの場合は、Phone Profiles ウィンドウとタスク ボタンを使用して

電話機の設定値を設定できます。詳細については、P.4-18 の「Phone Profile
ウィンドウ」を参照してください。

Cisco 7920 設定ユーティリティの電話機への接続

USB ケーブルを使用して、Cisco 7920 Configuration Utility を実行しているコン

ピュータに電話機を接続します。 ソフトウェアに付属の専用 USB ケーブルまた

は標準 USB ケーブル（タイプ 2）が付いたデスクトップ チャージャーを使用で

きます。

（注） ソフトウェアに付属の専用 USB ケーブルまたは標準 USB ケーブル（タ
イプ 2）が付いたデスクトップ チャージャーを使用できます。
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電話機の USB ポートをアクティブにするには、電話機の［デンワノセッテイ］

メニューにアクセスする必要があります。 次の項で、電話機への接続に役立つ情

報について説明します。

• 電話機の USB ポートのアクティブ化（P.4-6）

• Cisco Unified Wireless IP Phone への接続（P.4-6）

電話機の USB ポートのアクティブ化

電話機で Cisco 7920 Configuration Utility を使用するには、接続する前に USB ポー

トをアクティブにする必要があります。

手順

ステップ 1 Cisco Unified Wireless IP Phone 7920 の電源をオンにします。

ステップ 2 電話機の USB ポートを有効にするには、［メニュー］ソフトキーを押してから、

［デンワノセッテイ］>［USB ユウコウ / ムコウ］>［ユウコウ］を選択します。 

ステップ 3 USB ケーブルを使用して、PC と Cisco Unified Wireless IP Phone 7920 を接続しま

す。

Cisco Unified Wireless IP Phone への接続

USB ポートを有効にした後は、次の手順に従って電話機にログインできます。

（注） USB を使用して電話機に接続できるようにするには、PC で動作してい
るローカル ファイアウォールをすべて無効にする必要があります。
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手順

ステップ 1 アプリケーションを起動するには、［スタート］>［プログラム］> Cisco Systems

7920 >［Cisco 7920 設定ユーティリティ］を選択します。

設定ユーティリティは、Connection > Login を自動的に実行して Cisco Unified

Wireless IP Phone 7920 と PC を接続します。 

ステップ 2 ログイン ウィンドウで、デフォルトのユーザ名 Admin を選択し、パスワード cisco

を入力します （オンライン インジケータについては、P.4-9 の「接続ステータス

バーの情報」を参照してください）。 

（注） 管理者のパスワードを変更するには、Edit > Change Admin Password を
選択します。

その後、7920 設定ユーティリティが Current Phone Settings ウィンドウに電話機の

設定データをロードします。 

ステップ 3 既存の電話設定を変更するには、P.4-18 の「Phone Profile ウィンドウ」を参照し

てください。

（注） 電話機への接続に関して問題がある場合は、P.4-43 の「Cisco 7920 設定ユーティ

リティのネットワーク接続のトラブルシューティング」を参照してください。
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アプリケーション ウィンドウの概要
Cisco 7920 設定ユーティリティのグラフィカル ユーザ インターフェイスには、新

しい電話機の追加や既存の電話機の変更ができる次のウィンドウがあります。

• Current Phone Settings：現在の電話機の設定についての情報が表示されます。 

• Configuration Wizard：電話機を設定する手順が表示されます。

• Phone Profile：カテゴリ タブ ページで構成された設定フィールドが表示され

ます。

• Log History：ファイル内の電話機の設定イベントをキャプチャします。

この項では、設定ユーティリティのユーザ インターフェイスとメニューのオプ

ションについて説明します。次の項目で構成されています。

• Current Phone Settings ウィンドウ（P.4-8）

• Configuration Wizard の使用（P.4-16）

• Phone Profile ウィンドウ（P.4-18）

• Log History ウィンドウ（P.4-41）

Current Phone Settings ウィンドウ

図 4-1 は、設定ユーティリティが電話機に接続すると表示される Current Phone

Settings ウィンドウです。 電話機の設定のフィールド値は表示のみです。設定ファ

イルを変更するには、Configuration Wizard か Phone Profile ウィンドウを使用する

必要があります。



4-9
Cisco Unified Wireless IP Phone 7920 アドミニストレーション ガイド for Cisco Unified CallManager Releases 4.2 and 5.0(SCCP)
OL-9536-01-J

第 4 章      Cisco 7920 設定ユーティリティの使用

アプリケーション ウィンドウの概要

図 4-1 Cisco 7920 設定ユーティリティ - Current Phone Settings ウィンドウ

接続ステータス バーの情報

Connection メニュー オプションを使用して電話機にログインすると、左下の LED

インジケータに現在の接続ステータスが表示されます（表 4-1 を参照）。
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設定ユーティリティのメニューの使用

設定ユーティリティには、次のメニュー オプションがあります。

File メニューのオプション

File メニューには、次の標準 Windows オプションがあります。

• New：電話機の新しい設定ファイルを開きます。

• Open：既存の設定ファイルを探して開きます。

• Save：設定ファイルへの変更を保存します。

• Save As：設定ファイルに新しいファイル名を付けて変更を保存します。

• Exit：アプリケーションを閉じます。

表 4-1 接続ステータス

ステータス イン
ジケータ 操作 説明

Connection > Login を選択し

ます。

インポート、エクスポート、ま

たはファームウェア イメージ

のアップロード オプションを

選択します。

電話機は接続中です。

インポート、エクスポート、またはファームウェ

ア イメージのアップロード オプションの実行時

に接続は実行中になります。

メニュー バーから Connection

> Login を選択します。

電話機はオンラインで、接続が確立されています。

ユーザは、インポート、エクスポート、および

ファームウェア イメージのアップロード オプ

ションを実行できます。

Connection > Logout を選択し

ます。

USB ケーブルを取り外しま

す。

電話機はオフラインです。

ユーザは、インポート、エクスポート、または

ファームウェア イメージのアップロード オプ

ションを実行できません。
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Edit メニュー オプション

Edit メニューには、次の標準 Windows 編集オプションがあります。

• Cut

• Copy

• Paste

Edit メニューから次のオプションにアクセスできます。

• Configuration Wizard および Phone Profile

• Change Admin Password

View メニュー オプション

設定ユーティリティを起動すると、Current Phone Settings ウィンドウと Log

History ウィンドウが自動的に表示されます。 View メニューを使用して、次の

ウィンドウを切り替えたり、Toolbar と Status Bar の表示 / 非表示を切り替えたり

できます。

• Current Phone Settings

• Log History

• Toolbar

• Status Bar

Connection メニューの使用

Connection メニューを使用して、設定ユーティリティで次の作業を実行できま

す。

• ログイン（P.4-12）

• 管理者パスワードの変更（P.4-12）

• ログアウト（P.4-13）

• ファームウェア イメージのアップロード（P.4-14）

• 出荷時のデフォルト値にリセット（P.4-15）
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ログイン

インポート、エクスポート、またはファームウェアのアップロードを実行するに

は、電話機にログインする必要があります。 

電話機にログインするには、次の手順を実行します。

手順

ステップ 1 メニューバーの Connection > Login を選択します。 

Login ウィンドウが表示されます。

ステップ 2 ユーザ名とパスワードを入力します。 デフォルトのユーザ名とパスワードは表

4-2 に示すとおりです。

（注） キーロック パスワードを変更しなかった場合は、デフォルトのユーザ パスワー

ドを使用して電話機をロック解除できます。 ユーザがパスワードを変更し、それ

を思い出せない場合は、Technical Assistance Center（TAC）に連絡して、電話機

をリセットする必要があります。

 管理者パスワードの変更

初めて設定ユーティリティを起動したときには、ローカル コンピュータで使用

する Cisco 7920 Configuration Utility のパスワードを変更する必要があります。 管

理者パスワードを変更するには、管理者権限でログインする必要があります。

表 4-2 デフォルトのユーザ名とパスワード

ユーザ名 パスワード 認証

Admin cisco 設定ユーティリティ

User 12345 Cisco Unified Wireless IP Phone 7920
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管理者パスワードを変更するには、次の手順を実行します。

手順

ステップ 1 Edit > Change Admin Password を選択して、Change Admin Password ウィンドウ

を表示します。

ステップ 2 New Password フィールドに新規パスワードを入力します。

ステップ 3 Verify New Password フィールドに新規パスワードを入力します。

ステップ 4 OK をクリックします。

ログアウト

ログアウトすると、Cisco Unified Wireless IP Phone 7920 が PC から切断され、設

定ファイルのインポートとエクスポート、または電話機へのファームウェア イ

メージのアップロードができなくなります。 

USB ケーブルを切断すると、自動的にログアウトされます。 オンライン モード

で別の電話機に切り替えると、設定ユーティリティから自動的にログアウトしま

す。 

ログアウトするには、次の手順を実行します。

手順

ステップ 1 メニューバーから Connection > Logout を選択します。 

Logout ウィンドウが表示されます。

ステップ 2 ログアウトを確認するには、Yes をクリックします。
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ファームウェア イメージのアップロード

Upload Firmware Image ウィンドウでは、ファームウェア イメージのファイル名

を指定して Cisco Unified Wireless IP Phone 7920 にアップロードできます。

ファームウェアをアップロードするには、次の手順を実行します。

手順

ステップ 1 ログインするには、メニューバーの Connection > Login を選択します。 

ステップ 2 ユーザ名とパスワードを入力します。 P.4-12 の「ログイン」を参照してください。

ステップ 3 Connection > Upload Firmware Image を選択します。

ステップ 4 アップロードするファームウェア イメージのファイル名とパスを入力または選

択します。

ステップ 5 ファームウェア イメージがアップロードされると、Cisco Unified Wireless IP

Phone 7920 が自動的にリブートされ、履歴ログに uploading firmware image イベン

トが記録されます。

ステップ 6 設定ユーティリティを使用して Cisco Unified Wireless IP Phone 7920 の設定を続行

するには、再度ログインする必要があります。

注意 Cisco Unified CallManager のファームウェア イメージのバージョンが、電話機に

アップロードしたファームウェアのバージョンと同じであることを確認してく

ださい。 
Cisco Unified CallManager サーバのファームウェアのバージョンが異なっている

と、次に電話機が Cisco Unified CallManager に接続したときに、そのファームウェ

ア バージョンが Cisco Unified CallManager からダウンロードされます。
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出荷時のデフォルト値にリセット

設定を出荷時のデフォルト値に復元すると、通話履歴やプロファイル設定を含む

Cisco Unified Wireless IP Phone 7920 のすべての設定が元の設定に変更されます。

短縮ダイヤル設定はすべて削除されますが、電話帳に保存されているデータは残

ります。 

デフォルト設定に復元するには、次の手順を実行します。

手順

ステップ 1 メニュー バーから Connection > Restore to Factory Default を選択します。 

ステップ 2 デフォルトへの復元を確認するには、Yes をクリックします。

ステップ 3 出荷時の設定が復元されると、Cisco Unified Wireless IP Phone 7920 の電源が自動

的にオフになります。

ステップ 4 Phone Profile ウィンドウを使用して、カスタム ネットワーク設定を再設定する必

要があります。詳細については、P.20 の「Network Profile の設定」を参照してく

ださい。

関連項目

• Configuration Wizard の使用（P.4-16）

• Phone Profile ウィンドウ（P.4-18）



第 4 章      Cisco 7920 設定ユーティリティの使用

アプリケーション ウィンドウの概要

4-16
Cisco Unified Wireless IP Phone 7920 アドミニストレーション ガイド for Cisco Unified CallManager Releases 4.2 and 5.0(SCCP)

OL-9536-01-J

Configuration Wizard の使用

Cisco Unified Wireless IP Phone を初めて設定する管理者のために、Configuration

Wizard には順を追ったガイドと、さまざまなネットワーク設定値と電話設定値

に関する詳細情報が表示されます。

ウィザードを使用するには、次の手順を実行します。

手順

ステップ 1 Configuration Wizard にアクセスするには、Edit > Configuration Wizard を選択し

ます。 

Phone Profile ウィンドウの上部に Configuration Wizard ウィンドウが表示されま

す（図 4-2 を参照）。

ステップ 2 Configuration Wizard のメイン ページで、次の電話設定カテゴリのいずれかを選

択します。

• Network Profile

• Phone Settings

• User Profile

• Phone Lock Password

• Phone Book

• Speed Dial

Configuration Wizard に、カテゴリの設定手順およびエントリ フィールドの説明

が表示されます。 

ステップ 3 フィールドに値を入力して Finish をクリックします。 Phone Profile ウィンドウの

対応するタブ ページに、値と設定項目が表示されます。

ステップ 4 設定手順の画面を移動するには、ボタン（Back、Finish、Cancel）を使用します。
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図 4-2 Network Profile での Configuration Wizard の手順

関連項目

• Current Phone Settings ウィンドウ（P.4-8）

• Phone Profile ウィンドウ（P.4-18）
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Phone Profile ウィンドウ 

上級ユーザは、図 4-3 に示す Phone Profile ウィンドウを使用できます。 Phone

Profile ウィンドウを開くには、Edit > Configuration Wizard または File > New を

選択します。

図 4-3 Phone Profile ウィンドウ

タスク ボタン

Phone Profile ウィンドウの下部には、次の設定機能に簡単にアクセスできるタス

ク ボタンが表示されます。

• 電話の設定のインポート

• 電話の設定のエクスポート

• 別の電話機への変更
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電話の設定のインポート

Import ボタンをクリックして、USB ポートで接続されている Cisco Unified

Wireless IP Phone 7920 から設定を取得します。 インポートされた設定は、Phone

Profile ウィンドウの関連する設定タブに適用されます。

電話の設定のエクスポート

Export ボタンをクリックして、接続されている Cisco Unified Wireless IP Phone

7920 の設定を更新します。電話設定は、設定ファイルの設定値ですべて上書き

されます。 

（注） 電話機にエクスポートする設定ファイルのフィールドを空白のままにすると、電

話帳エントリなどの既存のエントリが消去されます。 

別の電話機への変更

管理者は、Change Phone ボタンを使用して、再度ログインしなくても別の電話

機に切り替えることができます。 

別の電話機に変更するには、次の手順を実行します。

手順

ステップ 1 Change Phone ボタンをクリックします。

ステップ 2 Wireless IP Phone から USB ケーブルを取り外します。 オンライン ステータス イ

ンジケータが赤に変わり、Offline と表示されます。

（注） Windows 2000 を使用している場合は、電話機から USB ケーブルを引き
抜く前に、Windows のステータス バーに表示される［ハードウェアの取
り外し］アイコン（ ）をクリックします。
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ステップ 3 USB ケーブルを次の Wireless IP Phone に差し込むか、電話機をデスクトップ

チャージャーに取り付けます。

ステップ 4 電話機の USB ポートが有効になっていることを確認します。P.4-6 の「電話機の

USB ポートのアクティブ化」を参照してください。

ステップ 5 インターフェイスがアクティブになるまでしばらく待ってから、OK をクリック

します。 緑色のオンライン ステータス インジケータが表示されます。

関連項目

• Phone Profile ウィンドウの使用（P.4-20）

• Configuration Wizard の使用（P.4-16）

Phone Profile ウィンドウの使用

Phone Profile ウィンドウのタブから設定ウィンドウにアクセスし、次の作業を実

行できます。

• Network Profile の設定（P.4-20）

• 電話の設定値の設定（P.4-29）

• ユーザ プロファイルの設定（P.4-33）

• 電話帳の設定（P.4-37）

• 電話ロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

Network Profile の設定

Network Profile タブ ページでは、電話機のネットワーク プロファイルを最大 4 つ

設定できます。 各プロファイルに名前を付け、特定の SSID の設定値を入力でき

ます。 たとえば、最も頻繁にアクセスされる SSID と WLAN ロケーションに

Profile 1 を設定します。 ネットワーク内の他の場所またはオフィスの WLAN に

アクセスできるように、他のプロファイルを設定できます。
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ネットワーク プロファイルには、次のタイプのパラメータと設定が記述されて

います。

• システム パラメータ

• RF ネットワークの設定

• ネットワーク セキュリティの設定

プロファイルの命名とプロファイル属性の設定

プロファイルに一意の名前を付け、容易に識別できるようにすることができま

す。 

また、プロファイルを自動選択するように電話機を設定したり、アクティブ プ

ロファイルを指定したりできます。 ネットワーク プロファイルを変更できるか

どうかを制御できます。 

これらのオプションを設定するには、次の手順を実行します。

手順

ステップ 1 Phone Profiles ウィンドウで、Network Profiles タブをクリックします。

ステップ 2 変更するプロファイルの Profile ボタンをクリックします。

ステップ 3 Profile Name フィールドに、選択したプロファイルの名前を入力します（最大 20

文字）。

ステップ 4 アクティブ プロファイルを設定するには、アクティブにするプロファイルの下

にあるラジオ ボタンをクリックします。 

（注） 複数のプロファイルをアクティブとして設定するには、Auto 設定を使用
します。 電話機は、Profile 1 から、ネットワーク プロファイルをすべて
スキャンします。最も優先順位の高いプロファイル（最高が 1、最低が
4）を使用し、アクセス ポイントからの応答があるまでスキャンします。 
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ステップ 5 ユーザがこのプロファイルを変更できるようにするには、Profile Modifiable 

チェックボックスをオンにします。

チェックボックスをオフのままにすると、ユーザはこのプロファイルに対する変

更を制限されます。 設定ユーティリティを使用した場合のみ、このフィールドを

リセットできます。

システム パラメータの設定

System Parameter セクションには、DHCP を有効 / 無効にするオプションと、TFTP

オプションを設定するオプションがあります。

ネットワークで DHCP を使用する場合は、DHCP クライアントを有効にして、IP

アドレスを Cisco Unified Wireless IP Phone に動的に割り当てます。これにより電

話機は、DHCP サーバからの情報を自動的に取得できます。 DHCP クライアント

を無効にする場合は、IP アドレス、サブネット マスク、および他の IP 設定にス

タティック IP 設定を指定する必要があります。 

また、DHCP で TFTP サーバを判別したり、特定の TFTP サーバの IP アドレスを

割り当てたりすることも選択できます。

DHCP クライアントの有効化または無効化

DHCP クライアントを有効または無効にするには、次の手順を実行します。

手順

ステップ 1 設定対象のプロファイルの System Parameter エリアに移動します。

ステップ 2 次の DHCP 設定の中からいずれか 1 つを選択します。

• DHCP クライアントを有効にするには、DHCP Client チェックボックスをオ
ンにします。

スタティック IP 設定のオプションは指定できません。
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• DHCP クライアントを無効にするには、DHCP Client チェックボックスをオ
フにします。

スタティック IP 設定のオプションを指定できます。

ステップ 3 DHCP Client オプションの下で、次のスタティック IP 設定を入力します。 

• IP Address：Cisco Unified Wireless IP Phone 7920 の IP アドレスを入力します。

• Subnet Mask：IP サブネット マスク アドレスを入力してサブネットワークを
識別し、LAN での IP アドレスが認識されるようにします。 

• Primary TFTP Server：ファイル ロケーションを識別するための TFTP サーバ
アドレスを入力します。Cisco Unified Wireless IP Phone 7920 の設定ファイル
とファームウェア イメージは、TFTP サーバに配置します。

• Primary Gateway IP Address：プライマリ ゲートウェイ アドレスを入力しま
す。 プライマリ ゲートウェイ アドレスにより、パケットの転送先となる次
のネットワーク ポイントが決まります。 

• Primary DNS Server：DNS サーバのアドレスを入力します。 DNS は、インター
ネット ドメイン名を IP アドレスに変換します。 

• Secondary DNS Server：バックアップ DNS サーバのアドレスを入力します。 

TFTP オプションの設定

電話機からの TFTP サーバへのアクセス方法を設定するには、次の手順を実行し

ます。

手順

ステップ 1 設定対象プロファイルの System Parameter エリアに移動します。

ステップ 2 FTP Option グループで、次のいずれかの設定を選択します。

• DHCP サーバが TFTP サーバを判別できるようにするには、Use DHCP をオ
ンにします。

• プライマリ TFTP サーバの IP アドレスを指定するには、Use Static ラジオ ボ
タンをオンにします。 Primary TFTP Server の IP アドレスの入力フィールドが
アクティブに変わります。
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ステップ 3 Use Static を選択した場合は、TFTP サーバの IP アドレスを入力する必要があり

ます。

RF ネットワークの設定値の設定

Network Profiles ウィンドウの RF Network（RF は無線周波数）セクションで、電

話機について次の無線ネットワーク設定を行います。

• Transmit power：無線送信電力レベルをミリワット（mW）単位で表した値。

• Data rate：データ転送レートをメガビット / 秒（Mbps）で表した値。

• Service Set Identifier（SSID）：相互に通信する無線デバイスのセットの識別

子。 無線電話機のグループをサポートするために、複数のアクセス ポイント

が同じ SSID を使用できます。

• WPA Pre-shared Key：アクセス ポイントと電話機で設定されるパスワード フ
レーズで、16 進数の文字列または ASCII パスワード フレーズのどちらかを

使用します。 この設定の詳細については、P.2-19 の「認証方式と暗号化方式

の選択」を参照してください。

RF ネットワークの設定値を設定するには、次の手順を実行します。

手順

ステップ 1 設定するプロファイルの RF Network エリアに移動します。

ステップ 2 Transmit Power を設定するには、ドロップダウン リストの矢印をクリックして、

適切な電力設定を選択します （デフォルト設定は 20mW）。

（注） アクセス ポイントで Client Transmit Power が設定されている場合、電話
機は自動的に、アクセス ポイントが無線 LAN でブロードキャストする
電力設定を使用します。 アクセス ポイントの設定が最大（Max）になっ
ている場合、そのアクセス ポイントでは電話機の Transmit Power 設定を
使用します。
Dynamic Transmit Power Control（DTPC; 送信電力の動的制御）は、リリー
ス 1.08 以降のファームウェアで使用できます。
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ステップ 3 Data Rate を設定するには、ドロップダウン リストの矢印をクリックして、適切

なデータ レート設定を選択します （アクセス ポイントが通知したデータ レート

を使用する場合のデフォルト設定は Automatic です）。

（注） データ レートの設定は、電話機が使用する最大レートです。 11 Mbps に
設定すると、電話機はネットワークのトラフィック タイプに応じて、1、
2、5.5、または 11 Mbps の速度で伝送します。 
Automatic に設定すると、電話機はアクセス ポイントの設定で指定され
たデータ レートを使用します。

ステップ 4 SSID の設定を入力するには、ドロップダウン リストの矢印をクリックして、次

のいずれかを選択します。

• Any：ネットワーク上に SSID をブロードキャストしている任意のアクセス
ポイントを使用します。 

• Specify：SSID を指定します。 

ステップ 5 Specify を選択した場合は、32 桁までの SSID をフィールドに入力します。 

（注） SSID では大文字と小文字が区別されます。文字は、アクセス ポイント
で設定されているとおり正確に入力してください。

ステップ 6 WPA Pre-shared Key を入力するには、パスワード形式（16 進数または ASCII）の

ラジオ ボタンをクリックし、パスワード フレーズを入力します。

• Hexadecimal：64 文字の 16 進数（0 ～ 9 および A ～ F）が必要です。

• ASCII：8 ～ 36 個の ASCII 文字列が必要です。 0 ～ 9、A ～ Z（大文字と小文
字）、および /、*、% などの記号を使用できます。
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（注） WPA 事前共有キーを設定するには、認証タイプを AKM に設定する必要
もあります。P.4-26 の「セットワーク セキュリティの設定値の設定」を
参照してください。

セットワーク セキュリティの設定値の設定

Network Profile ウィンドウの Network Security セクションで、セキュリティ設定

用の認証タイプと暗号化方式を選択します。 これらのオプション設定の詳細に

ついては、P.5-14 の「認証および暗号化の設定の選択」を参照してください。

認証タイプ

次のタイプの認証方式を設定できます。

• オープン：アクセス ポイントに自由にアクセスできます。 必要に応じて、暗

号化タイプを静的 Wired Equivalent Privacy（WEP）キーに設定するオプショ

ンも選択できます。

• 共有キー：ローカル アクセス ポイントでの Shared Key セキュリティ オプ

ションを有効にします。 共有キー認証タイプに設定する場合は、暗号化タイ

プを必ず静的 WEP キーに設定する必要があります。

• EAP：シスコの専用プロトコルである Cisco Light Extensible Authentication
Protocol（EAP）を有効にします。EAP は、WLAN 環境で中央集中型の RADIUS
サーバを使用することによって無線デバイスを認証するように設計されて

います。 

• AKM：Authenticated Key Management（AKM）を有効にします。AKM によ

り電話機は、アクセス ポイントによる選択に基づいて、アクセス ポイント

およびキー管理方式のタイプ（WPA、CCKM、または WPA Pre-shared Key）
を選択できます。 
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認証タイプを設定するには、次の手順を実行します。

手順

ステップ 1 設定するプロファイルの Network Security セクションにある、Authentication Type

エリアに移動します。

ステップ 2 次の認証タイプの中からいずれか 1 つを選択します。

• オープン：アクセス ポイントと電話機の間でオープン セキュリティを有効
にするには、Open ラジオ ボタンをオンにします。

• 共有キー：アクセス ポイントと電話機の間のセキュリティを有効にするに
は、Shared Key ラジオ ボタンをオンにします。

• EAP：EAP の設定フィールドに値を入力するには、EAP ラジオ ボタンをオ
ンにします。 ネットワーク アクセス サーバ（RADIUS サーバ）で権限を与え
られたユーザ名とパスワードを指定します。それぞれのユーザ名またはパス
ワードの最大長は 32 文字です。

• AKM：設定フィールドにアクセスするには、AKM ラジオ ボタンをオンに
します。 CCKM または WPA を使用する場合は、ネットワーク アクセス サー
バ（RADIUS）サーバで権限を与えられたユーザ名とパスワードを指定する
必要があります。 それぞれのユーザ名またはパスワードの最大長は 32 文字
です。

（注） WPA 事前共有キーを使用する場合は、パスワード フレーズも設定す
る必要があります。P.4-24 の「RF ネットワークの設定値の設定」を
参照してください。

ステップ 3 アクセス ポイントでの認証前にパスワードの入力をユーザに要求する場合は、

Prompt Mode チェックボックスをオンにします。 チェックボックスをオフにす

ると、プロンプト モードが無効になります。
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暗号化タイプ

オープンまたは共有キー認証では、WEP 暗号化を使用することもできます。

Shared Key 認証タイプを選択する前に、Wired Equivalent Privacy（WEP）キーを

セットアップする必要があります。 Cisco Unified Wireless IP Phone 7920 では、

WEP キーを 4 個まで設定できます。暗号化キーは、16 進数文字を使用する 40

ビットまたは 128 ビットにすることができます。

ネットワークで WEP 暗号化を使用しない場合は、None を選択します。

WEP を設定するには、次の手順を実行します。

手順

ステップ 1 設定するプロファイルの Network Security セクションにある Encryption エリアに

移動します。

ステップ 2 4 つある WEP Key ラジオ ボタンの 1 つをクリックし、暗号化の設定フィールド

をアクティブにします。

ステップ 3 暗号化方式を選択して、適切なキーを入力します。

• ドロップダウン メニューから、40 Bit Encryption を選択します。 WEP Key
フィールドに、10 桁のキーを 16 進数形式（0 ～ 9、A ～ F）で入力します。

例：ABCD123456

• ドロップダウン メニューから 128 Bit Encryption を選択します。 WEP Key
フィールドに、26 桁のキーを 16 進数形式（0 ～ 9、A ～ F）で入力します。 

例：AB123456789CD123456789EF12

関連項目

• 電話の設定値の設定（P.4-29）

• ユーザ プロファイルの設定（P.4-33）

• 電話帳の設定（P.4-37）

• 電話ロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）
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電話の設定値の設定

Phone Profile ウィンドウの Phone Settings タブを使用して、次の項目を設定しま

す。

• 電話機の画面に表示されるディスプレイ メッセージのテキストの編集

• 呼び出しトーンの選択およびカスタマイズ

• 次の詳細設定を使用します。

－ Cisco Discovery Protocol（CDP; シスコ検出プロトコル）のパラメータの

設定

－ ユーザ インターフェイスの言語の選択

－ ソフトキーの設定の選択

－ バックライトの制御

メッセージの編集と呼び出しトーンの選択

メッセージと呼び出しトーンを設定するには、次の手順を実行します。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Settings タブをクリックします。

ステップ 2 Greeting Message フィールドで、電話機の起動時に表示されるテキスト（15 文字

まで）を入力または編集します。 

ステップ 3 Welcome Message フィールドに、電話機がスタンバイ モードのときに表示される

テキスト（10 文字まで）を入力または編集します。

ステップ 4 Ring Tone エリアで、次の設定を使用して呼び出しトーンを設定する必要があり

ます。

• Current Ring Tone：Cisco Unified Wireless IP Phone 7920 に設定されている現
在の呼び出しトーンを表示します。呼び出しトーンには、Chirp 1 と Chirp 2
の 2 種類があります。

• Ring List（*.xm）：XML 呼び出し音一覧ファイルを指定するには、「...」ボ
タンをクリックして、目的の呼び出し音一覧ファイルを選択します。
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• Ring Tone：ドロップダウン リストの矢印をクリックして、呼び出し音一覧
ファイルから使用する呼び出しトーンを選択します。

大きな音量の呼び出しトーンを呼び出し音一覧に追加する方法については、

P.7-19 の「大きな音の呼び出しトーンのダウンロード」を参照してください。

詳細設定の設定

Phone Settings ページの Advanced Settings セクションで、電話機の動作を制御す

る次のオプションを選択します。

CDP パラメータの設定

Cisco Discovery Protocol（CDP; シスコ検出プロトコル）は、すべての Cisco ネッ

トワーク機器で実行されるデバイス検出プロトコルです。 各デバイスは、識別

メッセージをブロードキャスト アドレス宛に送信し、各デバイスは他のデバイ

スによって送信される識別メッセージを監視します。

ネットワークで CDP を使用する場合は、次の手順に従って、電話機の CDP パラ

メータを設定します。

（注） シスコ製以外の機器を使用する場合は、CDP パラメータを無効にできま
す。

手順

ステップ 1 Advanced Settings エリアで、Cisco Discovery Protocol チェックボックスをオンに

して、CDP パラメータをアクティブにします。

ステップ 2 CDP Time To Live フィールドに、電話機のバッファに入った CDP パケットが破

棄されるまでの時間（0 ～ 255）を秒単位で入力します （デフォルト値は 180）。
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ステップ 3 CDP Transmit Interval フィールドに、Cisco Unified Wireless IP Phone 7920 から

CDP パケットを送信する間隔（0 ～ 65535 秒）を入力します（デフォルト値は 60）。

ソフトキーの設定の選択

Softkey Settings のエリアでは、電話機がアイドル状態のときに表示されるソフト

キー（PhBook または Services、Svcs は電話機のサービスを表します）を設定で

きます。

Call Up オプションを使用して、電話機がコールに接続されたときに表示される

ソフトキーを決定します。 Mute ソフトキーを表示させたり、必要に応じて、カス

タマイズしたソフトキー テンプレートを割り当ててキーの順序を変えたりする

こともできます。 Cisco Unified Wireless IP Phone にはソフトキーが 2 つしかない

ため、Mute ソフトキーを Cisco Unified CallManager のソフトキーの前に表示する

か、またはソフトキー テンプレートの一覧にあるソフトキーの後に表示するか

どうかを選択する必要があります。

また、Cisco Unified CallManager Administration で電話機を設定する場合に、これ

らの設定を選択することもできます。 Phone Configuration ページでは、Product

Specific Configuration Options を使用できます。 Cisco Unified CallManager 設定ファ

イルの設定は、設定ユーティリティでの設定よりも優先されます。詳細について

は、P.7-12 の「ソフトキー テンプレートの設定」を参照してください。

（注） Cisco Unified Wireless IP Phone の右矢印を押すと、ソフトキー テンプレートで定

義されている Cisco Unified CallManager のソフトキー全体をスクロールして表示

できます。 

これらの設定を変更するには、次の手順を実行します。

手順

ステップ 1 Advanced Settings エリアの Softkey Setting に移動します。 
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ステップ 2 Idle フィールドのドロップダウン矢印をクリックし、PhBook または Services を

選択します。 デフォルト設定は PhBook です。

ステップ 3 Call Up フィールドのドロップダウン矢印をクリックし、Mute または Softkey

from CM を選択します。デフォルト設定は Mute です。

言語の選択とバックライト設定

電話機の画面に表示される言語を選択し、バックライト オプションのオン / オフ

を切り替えることができます。 

これらの設定を変更するには、次の手順を実行します。

手順

ステップ 1 Advanced Settings エリアの Language の下に移動し、適切なラジオ ボタンをク

リックしてユーザ インターフェイスの言語を設定します。 デフォルト設定は

English です。

ステップ 2 Back Light フィールドで、On または Off をクリックして電話機のバックライト

オプションを設定します。 デフォルト設定は On です。

関連項目

• ユーザ プロファイルの設定（P.4-33）

• 電話帳の設定（P.4-37）

• 電話ロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）
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ユーザ プロファイルの設定

Phone Profile ウィンドウの User Profile タブでは、電話機ごとの個人プロファイル

の設定値を設定できます。

事前定義されたユーザ プロファイルにより、電話機の呼び出し音やトーンをす

ばやく変更できます。 さまざまな作業環境において、次のプロファイルを使用で

きます。

• Normal

• Silent

• Meeting

• Outdoors

たとえば、屋外で作業している場合は、Outdoors プロファイルを選択すると呼び

出し音量およびスピーカ音量が自動的に大きくなります。 Meeting プロファイル

を選択すると、呼び出し音量が最低レベルまで下がります。Silent プロファイル

を選択する場合には、呼び出し音がオフになります。

表 4-3 に、ユーザ プロファイルのデフォルト設定値の一覧を示します。

 
表 4-3 個人プロファイルのデフォルト設定

設定のタイプ

プロファイル

Normal Silent Meeting Outdoors

Speaker Volume 3 3 3 5

Ring Volume 4 0 1 6

Incoming Call Alert On Off On On

Vibrating Call Alert Off Off Off On

Keypad Tones Off Off Off On

Warning Style Tone Off Off Tone
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ユーザ プロファイルの設定のオプション

プロファイルのデフォルト設定を使用するか、設定を調整して必要に合わせるこ

とができます。

たとえば、Normal プロファイルを選択し、Warning Tone を Tone から Vibrate に

変更できます。

個人プロファイルの変更

個人プロファイルのデフォルト設定を変更するには、次の手順を実行します。

手順

ステップ 1 Phone Settings タブをクリックします。

ステップ 2 変更するプロファイルのボタンをクリックします。 そのプロファイルのデフォ

ルトまたは現在の Mode 設定が表示されます。

ステップ 3 Speaker Volume フィールドで、音量を大きくするにはスライダをクリックして

右方向に動かし、音量を下げるには左方向に動かします。

ステップ 4 Ring Volume フィールドで、音量を大きくするにはスライダをクリックして右方

向に動かし、音量を下げるには左方向に動かします。

ステップ 5 Incoming Call Alert フィールドで On または Off をクリックし、警告オプション

を有効または無効にします。 無効（Off）にすると、呼び出し音もバイブレーショ

ンも作動しません。

ステップ 6 Vibrating Call Alert フィールドで On または Off をクリックし、バイブレーショ

ン オプションを有効または無効にします。 コール警告として、呼び出し音とバイ

ブレーションの両方を有効にできます。

ステップ 7 Keypad Tones フィールドで On または Off をクリックし、キーパッドでキーを押

すときのトーンを有効または無効にします。
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ステップ 8 Warning Style フィールドで、次のオプションのいずれかを選択し、バッテリ残

量が少なくなった場合、RF 信号が弱くなった場合、または音声メッセージを受

信した場合に警告が出されるようにします。

• Tone：短いトーン音を送信する

• Vibration：短いバイブレーションを起こす

• Off：警告オプションを無効にする

関連項目

• Network Profile の設定（P.4-20）

• 電話の設定値の設定（P.4-29）

• 電話帳の設定（P.4-37）

• 電話ロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

電話ロック パスワードの設定

セキュリティを強化するために、電話機にパスワード保護を設定できます。

Settings メニューと Phone Lock オプションを使用して電話ロックを有効にする場

合は、電話機をアクセス ポイントと関連付ける前にパスワードを入力する必要

があります。 

Phone Profile ウィンドウの Phone Lock Password タブを使用して、次の設定を行い

ます。

• 電話ロック機能を有効 / 無効にする

• 電話ロック パスワードをデフォルト値にリセットする

• 電話ロックのパスワードを変更する
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電話ロックとパスワードの設定

電話ロック機能を有効にするには、次の手順を実行します。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Lock Password タブをクリックします。

ステップ 2 電話ロック機能を有効にするには、Phone Lock Enable チェックボックスをオン

にします。 デフォルトではオフになっています。 

ステップ 3 Change Password チェックボックスをオンにします。

ステップ 4 New Password フィールドに、長さが 10 文字までのパスワードを入力します。 パ

スワードには、0 ～ 9 の数字、* または # などの記号を使用できます。

ステップ 5 Verify New Password フィールドに、同じパスワードを再入力します。

電話ロック パスワードのデフォルト値へのリセット

電話機からパスワードを消去する必要が生じた場合は、パスワードをデフォルト

のパスワード（12345）にリセットできます。 この手順に従ってパスワードをリ

セットする場合、電話設定データはすべて保持されます。

パスワードをリセットするには、次の手順を実行します。

手順

ステップ 1 Phone Lock Password タブをクリックします。

ステップ 2 Reset Password to Default チェックボックスをオンにします。
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（注） 電話ロックを解除するデフォルトのパスワードは、「12345」であることをユーザ

に通知する必要があります。

ロックされた電話機の電話ロック パスワードのリセット

ユーザが電話機をロックし、そのパスワードを忘れた場合は、電話の電源がオン

で、アクセス ポイントに関連付けられている場合にのみ、電話ロック機能とパ

スワードを無効にすることができます。 デフォルト パスワード（12345）を使用

しても電話機をロック解除できない場合は、Cisco Technical Assistance Center

（TAC）に連絡して、電話機を出荷時のデフォルト値にリセットする必要があり

ます。

注意 電話機を出荷時のデフォルト値にリセットすると、短縮ダイヤル、通話履歴、お

よびプロファイル設定などのすべての電話設定が削除されます。 また、ネット

ワーク設定がデフォルト設定にリセットされるので、電話機はアクセス ポイン

トやテレフォニー ネットワークに接続できなくなります。 

関連項目

• Network Profile の設定（P.4-20）

• 電話の設定値の設定（P.4-29）

• ユーザ プロファイルの設定（P.4-33）

• 電話帳の設定（P.4-37）

• 短縮ダイヤル ホットキーの設定（P.4-39）

電話帳の設定

Cisco Unified Wireless IP Phone 7920 には、ローカル電話帳の機能が組み込まれて

います。 ユーザは、電話機の［ディレクトリ］メニューを使用して自分の電話帳

にエントリを追加します。 ユーザは、PhBook ソフトキーを押し、エントリの名

前を指定し、［コール］ボタンを押すことにより、自分の電話帳エントリを使用

してコールを発信できます。 
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Phone Profile ウィンドウの Phone Book タブにアクセスすることにより、Cisco

7920 Configuration Utility を使用して電話帳のエントリを追加、変更、および削除

できます。 また、共通の電話帳エントリのリストを作成し、カンマ区切り形式

（CSV）ファイルとして保存することもできます。 管理者は、CSV ファイルを電

話機の電話帳にインポートするか、電話機の既存の電話帳エントリを CSV ファ

イルに保存することができます。

電話帳のエントリを操作するには、次の手順を実行します。

手順

ステップ 1 Phone Profile ウィンドウで、Phone Book タブをクリックします。

Phone Book ウィンドウの下部セクションに、設定されている電話帳のエントリ

が表示されます。 

ステップ 2 新しいエントリを追加するには、次のフィールドに適切な情報を入力します。

• Name（20 文字まで）：エントリはアルファベット順にソートされるので、姓
名を最初に入力するかどうかを決定します。

• Office Number（23 桁まで）：ローカル内線番号、またはアクセス コードと
エリア コードを含む完全な電話番号を入力します。

• Home Number（23 桁まで）：ローカル番号、またはアクセス コードとエリ
ア コードを含む長距離番号を入力します。

• CellPhone Number（23 桁まで）：ローカル番号、またはアクセス コードとエ
リア コードを含む完全な長距離番号を入力します。

• Email Address（48 文字まで）：参照専用の E メール ID を入力します。

ステップ 3 電話帳にエントリを追加するには、Add をクリックします。 

ステップ 4 既存のエントリを修正するには、下部セクションでスクロールし、エントリを強

調表示させます。 Edit Phone Book セクションに表示されるテキストを編集し、

Modify をクリックします。

ステップ 5 既存のエントリを削除するには、下部セクションでスクロールし、エントリを強

調表示させます。 Delete をクリックしてエントリを削除します。
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ステップ 6 電話帳のエントリが入っている CSV ファイル（Phonebook.csv）をインポートす

るには、Load をクリックします。

ステップ 7 既存の電話帳エントリを CSV ファイル（Phonebook.csv）として適当なディレク

トリに保存するには、Save をクリックします。

関連項目

• Network Profile の設定（P.4-20）

• 電話の設定値の設定（P.4-29）

• ユーザ プロファイルの設定（P.4-33）

• 電話ロック パスワードの設定（P.4-35）

• 短縮ダイヤル ホットキーの設定（P.4-39）

短縮ダイヤル ホットキーの設定

Cisco Unified Wireless IP Phone 7920 のユーザは、8 件の短縮ダイヤル番号をプロ

グラムできます。短縮ダイヤルは電話機にローカルで保存されます。 ユーザは、

キーパッドの数字キー（2 ～ 9）を使用して短縮ダイヤル番号にアクセスします。

番号 1 のキーはボイス メッセージ システムへのアクセス用に予約されていま

す。 短縮ダイヤル番号は、［メニュー］>［ディレクトリ］>［デンワチョウ］>［タ

ンシュクダイアル］の順に選択してプログラムします。

Phone Profile ウィンドウの Speed Dial タブでは、電話機の短縮ダイヤル ホット

キーを設定できます。 また、電話帳のエントリから短縮ダイヤル番号を選択する

こともできます。

短縮ダイヤル ホット キーを設定または変更するには、次の手順を実行します。

手順

ステップ 1 Phone Profile ウィンドウで、Speed Dial タブをクリックします。
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ステップ 2 数字キーに短縮ダイヤルを設定するには、Speed Button 番号の横の Dial Number

フィールドに、電話番号を表示されるとおり正確に入力します。 「9」または「1」

などのアクセス コード、およびエリア コードをすべて含めます。

ステップ 3 既存の番号を変更するには、Dial Number フィールドで変更します。

ステップ 4 電話帳にある電話番号を使用するには、「Import from Phone Book」ボタンを使用

します。 

関連項目

• Network Profile の設定（P.4-20）

• 電話の設定値の設定（P.4-29）

• ユーザ プロファイルの設定（P.4-33）

• 電話帳の設定（P.4-37）

• 電話ロック パスワードの設定（P.4-35）

設定テンプレートの作成

現在の電話機の設定を Phone Profile ウィンドウにインポートし、データを設定

ファイル テンプレートとして保存できます。 類似の設定で電話機を設定するた

め、設定ファイル テンプレートを他の Cisco Unified Wireless IP Phone にエクス

ポートできます。

設定ファイル テンプレートを作成するには、次の手順を実行します。

ステップ 1 File > New を選択して、新規の Phone Profile ウィンドウを開きます。

ステップ 2 Import ボタンをクリックして、Cisco Unified Wireless IP Phone 7920 から設定をイ

ンポートします。

ステップ 3 P.4-18 の「Phone Profile ウィンドウ」を使用して設定を変更します。 
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ステップ 4 設定ファイル テンプレートに設定を保存します。 

a. File > Save As  を選択します。

b. テンプレートの名前を入力します。

（注） ネットワークのセキュリティ設定（認証タイプ、WEP、EAP）または電
話ロック パスワードをテンプレートに保存することはできません。

ステップ 5 設定テンプレート ファイルを、別の Cisco Unified Wireless IP Phone 7920 にアッ

プロードします。 

a. 電話機に接続します。

b. 電話機にログインします。

c. Export ボタンをクリックします。 

ステップ 6 ネットワーク セキュリティ設定とパスワードは設定ファイルに保存されないた

め、これらの設定を各電話機に入力します。

Log History ウィンドウ

Cisco 7920 設定ユーティリティを起動すると、Log History ウィンドウが空の状態

で開きます。 電話機での操作を実行すると、各タイプのイベントが取り込まれ、

すぐに Log History ウィンドウに表示されます。 

履歴ログは、設定ユーティリティを終了するときに、コンピュータのハードディ

スクに保存されます。 終了時には、デフォルト ファイル名（logHistory.txt）の代

わりにログ ファイル名を選択するよう求めるプロンプトが表示されます。 

ログ ファイルは、簡単な ASCII テキスト エディタを使用して読むことができま

す。 Log History ファイルには、表 4-4 に示す項目が記録されています。
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（注） ログ履歴の既存のエントリは、削除されたり、新しいログ エントリによって上

書きされたりすることはありません。 新しいログ エントリは、保存されているロ

グ ファイルに追記されます。

表 4-4 Log History ファイルの情報

項目 記録される値

Time mm.dd.yyyy / hh.mm.ss（PC のローカル時刻）

Phone MAC 電話機のメディア アクセス 制御（MAC）アドレス

Type • Import 

• Export 

• Configuration 

Operation Import タイプ：インポートの設定

Export タイプ：

• エクスポートされた設定ファイルのエクスポート設定

• アップロード ファームウェア イメージと一緒に、アップ

ロードされた設定ファイルと電話機モデル番号

Configuration タイプ：

• 「Save」と保存された設定ファイル名

• 「Save As」と保存された設定ファイル名

• 「Open」と開かれた設定ファイル名
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Cisco 7920 設定ユーティリティのネットワーク接続のトラ
ブルシューティング 

Cisco 7920 設定ユーティリティを使用し、Cisco Unified Wireless IP Phone に接続

しているときに問題が発生した場合は、次の提案に従ってください。

他の TFTP アプリケーションを終了する

設定ユーティリティは、TFTP 用にポート 69 を使用します。したがって、アプリ

ケーションがこのポートを使用している場合には、設定ユーティリティを正常に

動作させるために、まずこのアプリケーションを終了する必要があります。

PC のファイアウォールを無効にする

コンピュータでファイアウォールを使用している場合は、電話機に接続するため

にそのファイアウォールを無効にする必要があります。

ネットワーク IP アドレスを確認する

Cisco 7920 設定ユーティリティを PC から起動すると、このユーティリティは、

USB インターフェイスを介して 192.168.1.x ネットワークへの接続を試みます。

無線ネットワークが 192.168.1.x ネットワークを利用していると、電話機の USB

ポートを有効にした後、USB アダプタは Cisco Unified Wireless IP Phone 7920 設

定のロードに失敗します。

PC と 192.168.1.x ネットワークの間のネットワーク接続性が存在しないようにす

るには、次の手順を実行します。

手順

ステップ 1 Cisco Unified Wireless IP Phone 7920 で、Network Config > 802.11b Configuration

> Wireless Settings を選択します。

ステップ 2 Service Set Identifier（SSID; サービス セット ID）または認証モードのどちらかを

変更します。

ステップ 3 電話機の電源をオフにします。
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ステップ 4 電話機の電源をオンにします。

ステップ 5 USB を有効にします。

ステップ 6 必要に応じて、Cisco 7920 設定ユーティリティを使用して電話の設定を変更しま

す。

関連項目

• Cisco 7920 設定ユーティリティの電話機への接続（P.4-5）

• Cisco 7920 設定ユーティリティの使用方法（P.4-5）
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